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Section 4 Charts
All graphics related to Microsoft in this book is in compliance with Microsoft guidelines and thus permitted by Microsoft.
➢➢ Objectives
By the end of this section you will be able to:
•

Create embedded charts

•

Create separate page charts

•

Change chart types and formats

•

Add and remove chart data

•

Add trend lines to charts

•

Create picture charts
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Charts

Introduction to Charting

One of the most impressive aspects of Excel is its charting ability. There are endless variations available, allowing you
to produce a chart, edit and format it, include notes, arrows, titles and various other extras as desired. This manual will
look at many of the issues involved in producing and formatting Excel charts.

Charts are based on data contained in Excel Worksheets. It is necessary to understand how Excel picks up the data to be
used in a chart because the way in which the data is laid out will influence how the chart is presented.
Excel offers a wide range of types and formats from which you can choose when producing charts. However, the charts
themselves can exist in different forms and it is important to understand the difference between them. The first form is
an embedded chart, the second is a separate chart page.

Terminology
As a starting point, there are some terms used in charting which should be understood by you. The terms defined below
relate to the example car sales worksheet and column chart which appear beneath the table:

Download free eBooks at bookboon.com

8

Excel 2007 Advanced: Part II

Data Point
Data Series
Legend
Marker
Category

Charts

An individual figure on the spreadsheet which is reflected in the chart e.g. Fred’s
Orion sales figure
A collection of related data points, e.g. all of Fred’s figures, which will appear on a
chart as markers (bars, for example) of the same colour
The “key” to the chart, identifying which patterns/colours relate to which data
series
A bar, column, or slice of pie for example, representing a data point
The category axis appears across the bottom of a graph (pie charts excepted) and
the categories are listed here. Points within the different data series are grouped
by category

Embedded Charts

360°
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An embedded chart appears on the worksheet where it was created. It is an embedded object, which does not normally
appear in its own window, and has no separate existence apart from the worksheet. The chart is saved only when the
worksheet file itself is saved, and will be printed with the worksheet in which it is embedded. You may choose to have an
embedded or separate chart at any time. All charts whether embedded or separate are created from the Insert ribbon
in the charts group.

Separate Chart Pages
A chart sheet, although linked to the worksheet whose figures it represents, exists as a separate page in a workbook. The
F11 key is very useful for creating a default chart from selected data as a new sheet within the workbook
Some chart elements to be aware of.
Chart Element

Description

Titles

Gridlines

This is the area where you can specify the titles to have on the chart (i.e. X-axis “1998”,
Z-axis “GBP”
Here you specify whether you want a Y/Z axis and whether you are using timescales to
plot your data
The gridline ribbon allows you to switch on and off horizontal and vertical gridlines

Legend

Use this ribbon to switch the legend on and off or reposition it

Data Labels

The Data Labels ribbon allows you to display the amount each point represents or display
the label (i.e. in the example above, each cylinder would have Qtr1, Qtr2 displayed as
appropriate at the top of each data marker)
The Data Table ribbon will display a grid underneath the chart that will show the
information that is being plotted.

Axes

Data Table
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Three Methods To Create Charts
➢➢ To create a chart

Mouse
a) Select data for chart.
b) Go to the charts group on the Insert ribbon. Select a chart type and click
c) The menu on the left appears.
d) Hovering your mouse over a chart type will bring up an explanation of that chart type
e) When you have chosen click once to select a chart type
f) The chart is now created based on the selected data as an embedded chart.
OR
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Keyboard
a) Select Data for chart
b) Press the F11 Key
c) Default chart will created as chart on a separate sheet.
OR
a) Select data for chart.
b) Click on the Dialog Box Launcher on the charts group on the Insert ribbon.

c) The following dialog will appear
d) Select a type from the left hand section and a sub type from the right hand section.
e) Click OK to create the chart.
f) This will be created as an embedded chart
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Moving And Resizing Embedded Charts
Once the chart object has been created and stored as an embedded object, you can move and resize it.
➢➢ To move an embedded chart:
Mouse
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a) Move mouse over the chart frame border your mouse cursor should have a four pointed black arrow
b) Click on the chart frame border and hold the mouse button down as you drag. Release the mouse when the
chart is in the desired location.
➢➢ To resize an embedded chart:
Mouse
a) Move your mouse over the dotted handles on the Chart frame border.
b) The mouse cursor should change to a double arrow.
c) Click and Drag up, down, left or right.
Hold down the [ALT] key if you wish the chart to resize by snapping to the cell gridlines

Data Layout
Depending on the “shape” of the selected data, Excel will assign categories and data series to either the rows or columns
of information. Usually it will be assumed that there are more categories than data series, therefore, if there are more
rows than columns of selected information, the data series will be based on columns, with the legend labels being picked
up from the row across the top of the selected area and the category labels being picked up from the leftmost column:
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If there are more columns than rows in the selected area, the data series will be based on rows, with the legend labels
being picked up from the leftmost column and the category labels taken from the top row of the selected area:

If the number of rows and columns is the same, Excel will opt for data series in rows. It is possible to override the choice
made by Excel in how the data series and categories are decided. Details of this procedure will be found under the section
on manipulating data.
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Shortcut Menu (Right Click)
You may be familiar with the Shortcut menus associated with the selected cell(s) on the Excel worksheet. When working
on a chart - embedded either on a worksheet or in its own window, clicking on the chart with the secondary mouse button
will call up a Charting Shortcut menu.
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The Shortcut menu will contain a selection of choices from some of the Standard Menu bar options mostly relating to
the chart as an embedded object - almost like a graphic on the worksheet.

Chart Types
There are several different types of chart available within Excel. The type to choose will vary depending on the data
involved and what information the chart is intended to convey or highlight. Practice will improve your instinct on which
type of chart to use in each instance. Initially it may be useful to try different types until the result is reasonably close
to your requirements, and then add custom formats and elements as desired. Some chart types are very specialised and
may only be of use to particular business sectors.
➢➢ Available Types Of Chart
Selecting any of the types listed will apply a given chart type to the active chart. The most useful types available and some
of their applications have been summarised below:
Area
Area charts can be 2 or 3-dimensional. They are used to compare the change in volume of a data series
over time, emphasising the amount of change rather than the rate of change. Area charts show clearly how individual
data series contribute to make up the whole volume of information represented in the graph.
Bar
Bar charts can be 2 or 3-Dimensional. They are used to show individual figures at a specific time or to
compare different items. Categories are listed vertically, so that bars appear on the horizontal, thus there is less emphasis
on time flow. Bars extending to the right represent positive values while those extending left represent negative values.
Column
Column charts can be 2 or 3-Dimensional. They are frequently used to show variation of different items over
a period of time. Categories (often days or months for example, representing a progression of time) are listed horizontally
and columns are displayed side by side, making for easy comparisons. Two variations on the theme of Column charts
are represented by further tools on the Chart toolbar. The Stacked Column chart can be used to show variations over
a period of time, but also shows how each data series contributes to the whole. A further variation on the 3-D column
chart produces 3-D columns in a 3-D plot area, receding away from the viewer.
Line
Line charts can be 2 or 3-Dimensional. Line charts are used to compare trends over time. There are
similarities with Area charts, but line charts tend to emphasise the rate of change rather than volume of change over time.
3‑D lines appear as “ribbons” which can be easier to see on the chart.
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Pie
Pie charts can be 2 or 3-Dimensional. They are used to compare the size of the parts with the whole.
Only one data series can be plotted, making up 100%. Pie charts within their own window can be made to “explode” by
dragging one or more pieces of pie away from the centre.
Radar
Each category in a radar chart has its own axis radiating from the centre point. Data points are plotted
along each spoke, and data points belonging to the same series are connected by lines.
Xy Scatter Charts
XY charts are used to compare two different numeric data series, and can be useful in determining whether one set of
figures might be dependent on the other. They are also useful if the data on the X axis represents uneven intervals of
time or increments of measurement.
3-D Surface
3-D Surface charts present information in an almost topographical layout. They can be used to pinpoint
the high and low points resulting from two changing variables. It can be helpful to think of a 3-D surface chart as a 3-D
Column chart which has had a rubber sheet stretched over the tops of the columns.
Combination
A combination chart allows you to overlay one 2-Dimensional chart type on top of another. This can be
useful for comparing different types of data, or for charting data requiring two different axis scales. Once the combination
chart has been set up, the actual type of the main or overlay chart can be changed by you.
➢➢ To change the chart type:
Mouse
a) Click on chart to be changed..
b) Go to the charts group on the Insert ribbon. Select a chart type and click
c) Hovering your mouse over a chart type in the menu will bring up an explanation of that chart type
d) When you have chosen click once to select a chart type
e) Your chart will have changed
OR
a) Click on the Dialog Box Launcher on the charts group on the Insert ribbon. The insert
Chart dialog will appear
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b) Select a type from the left hand section and a sub type from the right hand section. Click OK to change the
chart type
OR
a) Right click on the chart to call up the shortcut menu Click on change chart type
b) The insert Chart dialog will appear Select a type from the left hand section and a sub type from the
right hand section. Click OK to change the chart type
OR
a) Click on change chart type on the Type group on the design ribbon. The change chart
type Dialog box will appear
b) Select a new chart type
c) Click ok

Download free eBooks at bookboon.com
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Default Chart Type
The default graph setting in Excel is set to a simple 2‑dimensional column chart, however you can change the default to
any of the types offered within the chart type dialog.

➢➢ To set the default chart type:
Mouse
a) Click on the Dialog Box Launcher on the charts group on the Insert ribbon.
b) The following dialog will appear
c) Select a type from the left hand section and click on the specific format that you want the chart to have from
the gallery of pictures on the right.
d) Click the Set as default chart button.
e) New charts created from now on will use the default format as defined by you when pressing F11

4.2

Formatting Charts

There are several different ways of formatting the various elements in a chart. Some formats, such as adding a legend can
be applied to a chart using the following sections
Calling up the Shortcut menu on a Chart will also allow you to access the dialog boxes which can be used to change
formatting on the entire chart.

Design Ribbon
The design ribbon is to change some very basic aspects of your chart globally for the chart we have already looked at
changing the chart type. We will look at creating some of our own later on
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➢➢ To change data source
Mouse
a) Click on Chart.
b) Click on select data in the data group the following dialog will appear
c) In the Chart data range box a highlighted range will be seen.
d) If you need a completely new range then delete the values in this box and select a different range for your
chart.
e) Click on ok.

Be sure to include the row and column labels in this range. If you wish you may select more than one range by holding
down the [CTRL] key down after you have selected your first range and then select another range.
➢➢ To add or remove a series or category.
Mouse
a) Click on Chart.
b) Click on select data in the data group the select data source dialog will appear
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c) In the Legend entries (series) box click on add the Edit series dialog will appear.
d) In the series name box select the cell that holds the series Label
e) In the series values box select the range of cells that will make up the data for that series.
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f) Click ok
g) In the Horizontal (Category) axis labels box click on Edit
h) The axis labels dialog will appear

i) Reselect the range that will include any new category labels.
j) Click OK. and OK again to apply the new data to your chart.
➢➢ To delete a series
Mouse
a) Click on Chart.
b) Click on select data in the data group the select data source dialog will appear
c) Select the series you wish to delete.
d) Click on delete the series will be removed.
➢➢ To delete a category

a) Click on Chart.
b) Click on select data in the data group the select data source dialog will appear
c) Click on the switch row/column button. What was a category has now become a series
d) Now delete series as previously explained.
e) Click on the switch row/column button on the dialog box. What were series have now become
categories with the category you wished, removed.

Download free eBooks at bookboon.com

23

Excel 2007 Advanced: Part II

Charts

Switch Rows And Columns
➢➢ To switch between rows and columns

Mouse
a) Click on Chart.
b) Click on select data in the data group the select data source dialog will appear
c) Click on the switch row/column button. What was a category has now become a series
OR
Mouse
a) Click on chart.
b) Click on Chart.
c) Click on switch row/column in the data group
d) Your data has now switched rows to columns
This facility may not be available if multiple data ranges have been selected for your chart especially if they are different
sizes from different locations.

Changing The Chart Layout
As discussed earlier a chart is made up from many elements that can be turned on or off depending on the type of chart
or arranged in different places on the chart. To change the layout swiftly instead of laboriously changing each element
the change layout tool allows some quick global options.
➢➢ To change the chart layout
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Mouse
a) Click on the drop down arrow on the chart layout group
b) Select a chart Layout
c) The layout is applied

Chart Styles
A chart style is mainly a theme of formatting for your chart using the existing elements of your chart There are some very
exciting colour schemes in this feature
➢➢ To apply a chart style
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Mouse
a) Select chart
b) Click on the drop down arrow to the right of the chart styles group.
c) Select a chart style
d) Your chart should now adopt the style chosen.
If the chart style is not to your liking apply another style following the same method until you have a style close to what
you wish. We will look at formatting the various elements in a later chapter to achieve exactly what you want

Moving Chart Location

If you usually use one method to create a chart you will regularly get either a separate sheet chart or an embedded one and
you may wish to switch between the two types. Or move your embedded chart to a different sheet within your workbook.
➢➢ To move embedded chart between sheets
Mouse

a) Click on Move Chart on the Location group. A dialog will appear.
b) Click on drop down arrow to the right of Object in select the sheet you wish to move it to
c) Click ok
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➢➢ To switch between embedded and separate sheet
Mouse
a) Click on Move Chart on the Location group. A dialog will appear.
b) Click on New sheet
c) Name sheet in the text box
d) Click on OK
e) Embedded chart will now be on a separate sheet with the given name.
To create an embedded chart from a separate sheet chart simply CHOOSE AS OBJECT in the dialog box and select a
sheet to place it as an embedded object.

Layout Ribbon
The Layout ribbon allows us to format, add or remove various elements of a chart. Some tools are only available, however
for certain types of chart. E.G. you cannot apply 3D rotation to a 2D chart.

Formatting Chart Elements
➢➢ To select and format a chart element.

Mouse
a) Go to the Layout ribbon.
b) To select an element of your chart, click on the drop down arrow to the right of top box in the current
selection group.
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c) Click on a chart element. That element will be selected
d) Click on format selection in the current selection group, the following dialog will appear.
e) The left hand section of the dialog will give the various categories of how you may format your selection
(These options may vary depending on the selection.)
f) The right hand section contains the available formats for that category.
g) Clicking on each category and setting your format choices will immediately affect you chart.
h) When you are satisfied with your formatting choices, click close.

.
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Many of the options displayed in the category options section may involve other drop down boxes to make a selection.
(see picture) if you move your mouse over these possible selections a help tip should appear to give you a description
of that choice BEFORE actually making a selection. Any choice already applied will already be selected and have a
different colour.

Resetting Custom Formats
When experimenting with various formats you may find it difficult to remember exactly what settings were applied to a
specific element and therefore you would find it difficult to make it appear as it once was. Resetting the format of specific
chart elements can be very useful.
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➢➢ To reset an element
Mouse
a) Make a selection of element to be reset
b) Click on reset to match style button on the current selection group.
c) The selected element will revert back to the original format settings of the applied chart style.

Adding, Removing And Formatting Labels

Information labels on your chart are very important on your chart especially if it is on a separate sheet. The labels group
offers a selection of labels you may wish to show or hide on your chart. The chart layout choices previously explained uses
a mixture of labels in different locations on your chart but you may wish to put specific labels on your chart and format
them yourself and place them where you wish.
➢➢ To add or remove labels.

Mouse
a) Select chart if embedded
b) Click on drop down arrow of type of label you wish to add or remove from the labels group.
c) Make a selection from choices present.
d) Label will appear or disappear dependant on choice
e.g.
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e) Use the Data Labels button on the labels to write the values or the labels on the data markers.
f) Use the Data Table button on the labels to add the plot data so that it is visible on the chart itself.
➢➢ To format labels
Mouse
a) Select label element from drop down box in the current selection group as mentioned previously.
b) Click on format selection in the current selection group as mentioned previously.
➢➢ To edit label text
Mouse
a) Select label as previously discussed.
b) Click within the label and delete and retype with the text you require.
c) Click off label
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➢➢ To move or resize chart elements
Mouse

a) Make a selection of a chart element. (E.G. a label)
b) Handles will appear at each corner to show selection.
c) Moving mouse over label border should show a 4 pointed Black arrow. This appears to indicate that you are
in the right position to click and drag to move the selected element.
d) Clicking within the label to edit the text the label will automatically resize to the size of the text entered
Selecting an element like the plot area will allow a double black arrow when moving over a handle. Clicking and
dragging will resize that element.

Axes

For various types of charts you may not wish to see both axes on the chart you are able to hide or show these axes
dependant on your needs.
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➢➢ To add or remove axes from chart
Mouse

a) Select chart if embedded.
b) Click on drop down button on axes button on axes group
c) Select primary horizontal or primary vertical axis.
d) Make a selection from choices shown.
Selecting more primary horizontal or vertical options opens the formatting dialog which would appear if you selected
the axis and formatted it. Using the axes menu is best for turning it off or on.
➢➢ To format the Category (X) Axis:
Mouse
a) Under Tick Mark Type, you may click on the appropriate option button to specify that tick marks on
the axis will appear on the inside or outside of the axis line, cross the axis line, or not appear at all. Minor
tick marks can also be included (click on the Scale... button to set the intervals for major and minor tick
marks).
b) The Tick Labels section allows you to dictate where the Labels associated with the selected axis will
display. This can be at the High Values end of the axis, the low values end of the axis, next to the axis, or
completely suppressed.
c) Use the Scale ribbon to specify at where the value axis will appear, which categories are labelled and how
many categories will appear between each pair of tick marks.
d) A series of boxes [a]use automatic positioning. The default setting is to have this box checked, which
produces a Value Axis at the edge of a given category. Putting a value in the next box down will result in a
Value Axis which cuts down the middle of a category. This will also affect the location of tick marks on the
axis. Categories may be displayed in reverse order if desired, and the Value Axis may be required to cross at
the last plotted category on the chart.
e) Use the Alignment category to specify the orientation of the category labels.
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➢➢ To format the Value (Y) axis:
Mouse
a) Follow steps described above for the category axis.
b) The Scale ribbon will have different options relating to the values on the axis.
c) From the Scale ribbon, you may specify the Minimum and Maximum values to appear on the axis. The
intervals to be used as Major and Minor units on the axis may also be set. You may dictate the point at
which the value and category axes cross, whether or not the axes are plotted on a Logarithmic Scale, or
whether to have the values plotted in Reverse order.

Gridlines
Gridlines are the indicator lines that run across your chart to either divide up your categories or give visual help when
deciding on a value for a data point more distant from the value axis. You may need more, or less of these, dependant
upon your needs for accuracy or visual impact.
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➢➢ To change gridline options
Mouse
a) Select chart if it is embedded.
b) Click on drop down arrow on gridlines on the axes group.
c) Choose primary horizontal or primary vertical gridlines and make a selection from the
choices given.

Unattached Text
Floating text may be typed directly onto the Chart, then dragged to the desired position.
➢➢ To add floating text to a chart:
Mouse
a) Go to the Insert ribbon and select the text box button click on your chart and a text box will appear.
Type required text, resize and format text box and drag to required location.
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Format Dialog

➢➢ Element options
This category varies dependent on what is selected it may show axis, category or series options. For series
options it allows you to change the width of the column or gap between the series. axis options allows you to
specify widths and separation options where the axis begins and ends (if available)
➢➢ Fill
Use the fill category to specify background colours or designs.
➢➢ Shape
Use this category to set the shape for a selected element (series or data point if available)
➢➢ Borders
Select the border colour to change the border colour and set a border
Set the Border styles category to add a border around the outside of the selected element
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➢➢ Shadow
This option allows you to set the shadow depth , colour and direction for the selected element.
➢➢ 3-D Format
If you have a chart that has a 3-D format this category will allow you to change many aspects of the 3-D appearance such
as the material, lighting, contour, depth and bevel.
Depending on the data being displayed, some data markers on a 3-D chart may be obscured. It is possible to adjust
the view so that your data may be seen to its best advantage. You may influence the degree of elevation, perspective or
rotation of your chart. A sample chart within the 3-D view dialog box reflects the new views as you change these factors.
Elevation and Rotation can be adjusted either by typing values into the appropriate sections within the dialog box, or by
clicking on the arrow buttons displayed around the sample chart. The latter technique is obviously easier.
Elevation dictates the height from which you view the data. Ranging from 90°(above the plot area) to -90°(below the
plot area), where 0° represents a view level with the centre of the plot area. With 3-D Pie Charts, the range varies from
10°, almost level with the edge of the pie, to 80°, looking down on the surface of the pie.
➢➢ 3-D Rotation
Selecting the plot or chart area will allow you to rotate your chart in any direction or change the perspective of your chart.
Rotation
Rotation allows you to turn the graph on its vertical axis. The range goes from 0°to 360°, where zero views the chart
from the front, 90°would view it from the side, and 180° would allow you to see it from the back - effectively reversing
the order of the data series for the chart display.
Perspective
Perspective can be changed to make the data at the back of a 3-D chart appear more distant. A perspective of zero
means that the farthest edge of the chart will appear as equal in width to the nearest edge. Increasing perspective (up to
a maximum of 100) will make the farthest edge appear proportionally smaller.
You may also affect the height of the graph in relation to its width and whether or not you want the axes to remain at
right angles. This latter setting would preclude the use of perspective in 3-D charts. Auto-scaling allows Excel to scale a
3-D chart so that, where possible, it is similar in size to its 2-D equivalent.
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➢➢ Font
The font for any selected textual element can be set on the home ribbon from the font group or right clicking on the
highlighted text and using the mini toolbar.
➢➢ Formatting The Legend
The Legend can be selected and formatting like the other chart elements The legend can be positioned manually simply
by pointing and dragging it to a new position on the chart, but there are some preset positions which can be selected
from legend button in the Label group
Note that the legend cannot actually be resized. Changing the font size will cause the size of the overall legend to adjust,
but it cannot be resized by dragging on the selection handles. No chart element which shows white selection handles
(rather than the usual white) can be resized by dragging. Dragging the legend to a new position on the chart will
sometimes affect the shape of the legend and the size of the chart. The legend may be placed overlapping the chart. Note
that the text appearing in the Legend box is picked up from the worksheet data. Edit the text on the worksheet in order
to change the legend text (The legend may be deleted(hidden) by selecting it and pressing the Delete key on the keyboard.
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Add A Series Manually
➢➢ Other methods To add a new data series to a chart:
Mouse
a) Select the worksheet cells containing the relevant data (including the label to be used if labels were included
in the original data).
b) Copy this data to the clipboard in the usual way.
c) Activate the chart by clicking on it and choose Edit, Paste. The data series will appear in the chart.
OR
a) Select the worksheet cells containing the relevant data
b) If Chart is an embedded chart on current sheet. Drag and drop selected data onto chart.
The added series will invariably come in as the final data series, but the order can be changed by you as outlined later
in this document.

The Series Function
If a data series on a chart is selected, the reference area will display the underlying formula. It can be useful to know
what elements go to make up the Series function, as you may edit it manually if desired. The Series function includes
four arguments:
=SERIES(Series_Name,Categories_Ref,Values_Ref,Plot_Order)
The Series Name can be a reference (Worksheet!Cell) to the cell where the name of this particular data series is being
held, or it may consist of text typed in by you and enclosed in quotation marks. The Series Name will be picked up in
the legend to describe the data series. The Categories Reference refers to the worksheet name and range of cells where
the Category (or x-axis) labels are to be found. If the data series are in rows, the category references will refer to the
labels at the top of each column and vice versa. The Values Reference refers to the worksheet name and the range of cells
containing the actual values for this data series which are to be plotted on the y-axis (or z-axis on a 3-D chart). The Plot
Order number dictates the order in which the selected data series is plotted on the chart and listed on the legend. Often,
instead of amending the Series function manually, you may find it easier to edit a data series using the dialog option
covered in the earlier section.
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Charting With Blocks Of Data
As it is possible to select separate ranges in Excel, it is possible to produce charts based on non-contiguous data. This is
vital if some of the information on the worksheet is to be omitted. There are some guidelines to be aware of however.
The layout of data is important as was demonstrated at the beginning of this document. The selected ranges must amount
to a regular block with consistent height and width measurements so that Excel can interpret it correctly, with categories
and data series matching up. Once the data has been successfully selected, choose File, New and click on Chart before
clicking on OK, or tap [F11]. An extension of this idea leads to the fact that ranges from separate worksheet files can be
included in a single chart. Simply select the worksheet data to be included (subject to the layout provisos above), copy
to the clipboard then paste them into the chart.

Download free eBooks at bookboon.com

40

Excel 2007 Advanced: Part II

Templates

Section 5 Templates
➢➢ Objectives
By the end of this section you will be able to:
•

Use the standard Excel templates

•

Create Custom templates

•

Open and edit templates

•

Set template properties
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Introduction to Templates

A template is a file used as a form to create other workbooks, sheets and charts. New workbooks created from the template
contain the same layout, data, formulae, formats and styles as those of the template. New sheets and charts inserted into
a workbook are a copy of the sheet or chart template.

Standard Templates

Excel comes supplied with a selection of templates designed to help in the production of common business and home
financial tasks. These templates can be modified for personal use.
➢➢ To use a standard template:
Mouse
a)

Click on the Microsoft office button and select the New button, the dialog above will
appear

b) Click the Installed Templates button on the left to see a list of Excel templates in the centre section
of the dialog
c) Click on the Picture for the template you wish to base the new workbook on to see a preview on the right.
d) When you have located the template you wish to use click create.
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OR
a)

Click on the Microsoft office button and select the New button, the dialog above will
appear

b) Click under the Microsoft office online button on the left on a section pertaining to your need to
see a list of appropriate Excel templates in the centre section of the dialog.
c) Click on the Picture for the template you wish to base the new workbook on to see a preview on the right.
d) When you have located the template you wish to use click create.
N.B. You must be connected to the internet to use templates from Office online.

Custom Templates
You can create your own workbook and sheet templates.
➢➢ To create a workbook template:
Mouse
a) Open or create the workbook to be used as the basis for the template.

b)

Click on the Microsoft office button and select the save as button, click on excel
workbook, the save as dialog above will appear

c) Type the template name in the File name text box.
d) Select Excel Template from the Save as Type list. An .XLTx extension will be added to the
template name.
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e) The folder where the file will be stored will automatically change to Templates. By storing all .XLTx files in
the same folder Excel recognises and keeps track of templates.
f) Click save to save the template.
➢➢ To create a worksheet template:
Mouse
a) In a new or existing workbook delete all the sheets except the one to be used as the template.
b)

Click on the Microsoft office button and select the save as button, click on excel
workbook, the save as dialog will appear

c) Type the template name in the File name text box.
d) Select Excel Template from the Save as Type list. An .XLTx extension will be added to the
template name.
e) The folder where the file will be stored will automatically change to Templates. By storing all .XLTx files in
the same folder Excel recognises and keeps track of templates.
f) Click save to save the template.
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➢➢ To base a new workbook on a template:
Mouse
a)

Click on the Microsoft office button and select the New button, the New workbook
dialog will appear

b) Click the My templates button on the left a dialog will appear.

c) Click on the Picture for the template you wish to base the new workbook on to see a preview on the right.
d) When you have located the template you wish to use click create.
➢➢ To add a worksheet based on a sheet template:
Mouse
a) Click the right mouse button over a sheet tab and choose Insert.
b) click the icon for the worksheet template you want to base the new sheet on.
c) Click ok

AutoTemplates
An autotemplate is a workbook saved as a template in the XLSTART folder or alternate Startup folder using the specific
filename Book.xltx, sheet.xltx, dialog.xltx or macro.xltx. AutoTemplates if they exist will act as the basis for all new items
you create in the Excel environment.
The Book.xltx template becomes the default workbook. The Sheet.xltx template becomes the default worksheet.
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Opening And Editing Templates
Templates are files just like workbooks. If you need to change a template in any way, simply open, edit and save in the
normal way.
➢➢ To open a template:
Mouse
a)

Click on the Microsoft office button and select the Open button

b) Change the Look In location to the Templates folder.
c) Select the name of the template you want to open. click open
➢➢ To edit a template:
Mouse
a) Make changes in the open template.
b)

Click on the Microsoft office button and select the save button

Template Properties
Files have various properties that are saved with them. Some properties, such as date created and last saved date are
included and updated automatically by Excel. Others, such as title and subject must be entered manually by the user.
Properties are helpful when trying to locate files as you can use the properties to search.
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➢➢ To set template properties:
Mouse
a) With the template open

Click on the Microsoft office button and select the prepare

button and select properties.

b) .A section (above) will appear under the formula bar.
c) Set the properties that apply to the template.
d) Click X.in right hand corner of this bar to close
e) If you have further properties to set. Click on document properties on the bar and choose advanced
properties the dialog on the right will appear
f) the 5 separate tabs allow the input of many more pieces of information.
g) When complete click on ok

Templates can contain custom number formats and predefined styles.
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Section 6 Auditing
➢➢ Objectives
By the end of this section you will be able to:
•

Use and understand tracers

•

Insert and use cell comments

•

Use Watch window

•

Use go to special
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Auditing Features

Tracers
The precedent, dependent and error tracers display arrows on the worksheet to represent the flow of computations: The
can be found The formula auditing group and on the formulas ribbon.
Tracer Type
Formula
Error
External reference or reference to other worksheet

Arrow type
Solid blue
Solid red
Dashed black with an icon

COMMENTS

Comments are text or audio messages attached to cells usually giving a more detailed explanation of a cells content.
GO TO SPECIAL
A method of selecting cells with particular contents or properties.
PRECENDENTS AND DEPENDANTS
Precedents are cells referred to by other formulae. Dependants are cells containing formulae that refer to other cells.
A direct precedent is a cell referred to by the formula in the active cell. An indirect precedent is a cell referred to by a
formula in a direct precedent cell or another indirect precedent cell.
A direct dependant is a cell containing a formula that refers to the active cell. An indirect dependent is a cell that contains
a formula that refers to a direct dependant cell or another indirect dependant cell.
You use the Auditing toolbar to set auditing options.
Watch window
Is a useful tool which allows you to watch the values of calculated cells on other sheets while you change values that they
are dependant on, on a completely different sheet.
➢➢

To set a watch
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Mouse
a) Select a cell to which you want to add a Watch
b) Go to the formulas ribbon an click on watch window in the formula auditing group
c) Click on add watch
d) Select cell you wish to monitor
e) Click on add
f) You may now switch windows or scroll and the watch window will monitor that cell for changes in result as
you enter or manipulate figures elsewhere.

➢➢ To delete a watch
Mouse
a) Go to the formulas ribbon an click on watch window in the formula auditing group
b) Select watch to delete
c) Click on delete watch on watch window
➢➢ To audit for direct and indirect precedents:
Mouse
a)

Click on the cell you want to audit.

b) Click the trace precedents button on the Auditing toolbar.
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➢➢ To audit for direct and indirect dependants:
Mouse
a)

Click on the cell you want to audit.

b) Click the trace dependant’s button on the Auditing toolbar.
Click either button a second time to view indirect precedents or dependants of the active cell.
➢➢ To remove the tracer arrows:

Mouse
a) Click the remove precedent arrows to remove precedent tracers or remove dependant arrows to remove
dependant tracers.
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OR
a) Click the remove all arrows button to remove both precedent and dependant tracers.

Comments

When a cell has a comment attached, CellTips automatically display the comments added when the mouse pointer rests
over the cell. You can tell which cells have c comments attached as they have a comment indicator (a small red corner
triangle).
➢➢ To add a comment:
Mouse
a) Click in the cell where you want to insert a comment.
b) Choose Comment from the review ribbon
c) In the text box that appears attached to the cell, type your comment.
d) Click outside the text box to confirm the entry and close the text box.
➢➢ To view comments:
Mouse
a) Position your mouse over the top of the cell that contains the comment. Shown with a tiny coloured triangle
in top of the cell corner.
b) Your comment will be displayed as a CellTip.
➢➢ To edit comments:
Mouse
a) Click in the cell where you want to edit a comment.
b) Choose edit Comment from the review ribbon
c) In the text box edit your comment.
d) Click outside the text box to confirm the entry and close the text box.
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➢➢ Hiding and redisplaying comments:
Mouse

a) You can hide an individual comment by clicking the right mouse button over the cell that contains the
comment and choosing show/Hide comment from the shortcut menu.
OR
a) Click on show/hide comments in the comments group on the review ribbon
b) When you want to redisplay all individually hidden comments click on show all comments in
the comments group on the review ribbon
➢➢ To print comments:
Mouse

a)

On the Page Layout ribbon, in the Page Setup group, click the dialog box launcher next to Page
Setup.

b) On the Sheet tab, in the Comments box, click As displayed on sheet or At end of sheet.
c) Click Print.
To see how comments are printed, you can click Print Preview before you click Print.
➢➢ Reviewing comments:
Mouse
a) Go to the Comments group on the review ribbon.
b) To view each comment in sequence click the Next Comment button.
c) To view the comments in reverse order, click the Previous Comment button.
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Section 7 Other formatting
7.1

Formatting Cells

Themes
You can quickly and easily format an entire document to give it a professional and modern look by applying a document
theme (A set of unified design elements that provides a look for your document by using colour, fonts and graphics.). A
document theme is a set of formatting choices that include a set of theme colours, a set of theme fonts (including heading
and body text fonts), and a set of theme effects (including lines and fill effects).
Excel provides several predefined document themes, but you can also create your own by customizing an existing document
theme, and then by saving it as a custom document theme. Document themes are shared across Office programs so that
all of your Office documents can have the same, uniform look.
➢➢ To Apply a document theme
You can change the document theme that is applied by default in Office programs, such as Word, Excel and PowerPoint,
by selecting another predefined document theme or a custom document theme. Document themes that you apply
immediately affect the styles (A combination of formatting characteristics, such as font, font size, and indentation, that
you name and store as a set. When you apply a style, all of the formatting instructions in that style are applied at one
time.) that you can use in your document.
Mouse

a) On the Page Layout ribbon, in the Themes group, click Themes.
b) To apply a predefined document theme, click the document theme that you want to use under Built-In.
c) To apply a custom document theme, click the document theme that you want to use under Custom.
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Custom is available only if you created one or more custom document themes
d) If a document theme that you want to use is not listed, click Browse for Themes to find it on your
computer or a network location.
e) To search for other document themes on Office Online, click Search Office Online.

Customising A Theme
The collection of fonts, colours and effects that make up a theme can all be customised and then saved as a custom theme
➢➢ To customise a theme
a) Click on the drop down arrow next to the aspect of the theme you wish to change colours, fonts or effects.

b) Make a selection from the choices present.
c) Click on themes and save current theme
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d) Clicking on the themes button in future will display custom, to allow you to use this theme in future
workbooks.
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➢➢ To set custom colour schemes for a theme
Mouse
a) Click on the drop down arrow next to the colours button.
b) Select create new theme colours at the bottom of the menu

c) The dialog above is displayed
d) Select new colours for the various parts of your theme. A sample is shown on the right to show you how the
colours appear together

e) Enter a name for your colour scheme in the name box
f) Click on save.
g) Next time you click on the colours button it will display custom and the sets of colours you have created.
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➢➢ To create custom font schemes for a theme.
Mouse
a) Click on the drop down arrow next to the fonts button.

b) Select create new theme fonts at the bottom of the menu

c) The dialog above is displayed
d) Select Fonts for the heading and a font for the body text see sample on right of dialog.
e) Enter a name for your font scheme in the name box
f) Click on save.
g) Next time you click on the fonts button it will display custom and the sets of fonts you have created.

Styles
To apply several formats in one step, and to ensure that cells have consistent formatting, you can use a cell style. A cell
style is a defined set of formatting characteristics, such as fonts and font sizes, number formats, cell borders and cell
shading. To prevent anyone from making changes to specific cells, you can also use a cell style that locks cells. Microsoft
Office Excel has several built-in cell styles that you can apply or modify. You can also modify or duplicate a cell style to
create your own, custom cell style.
Cell styles are based on the document theme that is applied to the entire workbook. When you switch to another document
theme, the cell styles are updated to match the new document theme.
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How to select cells, ranges, rows, or columns
To select
A single cell
A range of cells

A large range of cells
All cells on a worksheet

Do this
Click the cell, or press the arrow keys to move to the cell.
Click the first cell in the range, and then drag to the last cell, or hold down SHIFT while you press
the arrow keys to extend the selection.
You can also select the first cell in the range, and then press F8 to extend the selection by using
the arrow keys. To stop extending the selection, press F8 again.
Click the first cell in the range, and then hold down SHIFT while you click the last cell in the
range. You can scroll to make the last cell visible.
Click the Select All button. To select the entire worksheet, you can also
press CTRL+A. If the worksheet contains data, CTRL+A selects the current
region. Pressing CTRL+A a second time selects the entire worksheet.

Nonadjacent cells or
cell ranges

An entire row or
column

Select the first cell or range of cells, and then hold down CTRL while you select the other cells
or ranges. You can also select the first cell or range of cells, and then press SHIFT+F8 to add
another nonadjacent cell or range to the selection. To stop adding cells or ranges to the selection,
press SHIFT+F8 again. You cannot cancel the selection of a cell or range of cells in a nonadjacent
selection without cancelling the entire selection.
Click the row or column heading.
Row heading
Column heading

Adjacent rows or
columns
Nonadjacent rows or
columns
The first or last cell in a
row or column
The first or last cell on
a worksheet or in a
Microsoft Office Excel
table
Cells to the last used
cell on the worksheet
(lower-right corner)
Cells to the beginning
of the worksheet
More or fewer cells
than the active
selection

You can also select cells in a row or column by selecting the first cell and then pressing
CTRL+SHIFT+ARROW key (RIGHT ARROW or LEFT ARROW for rows, UP ARROW or DOWN
ARROW for columns).If the row or column contains data, CTRL+SHIFT+ARROW key selects the
row or column to the last used cell. Pressing CTRL+SHIFT+ARROW key a second time selects the
entire row or column.
Drag across the row or column headings. Or select the first row or column; then hold down SHIFT
while you select the last row or column.
Click the column or row heading of the first row or column in your selection; then hold down
CTRL while you click the column or row headings of other rows or columns that you want to add
to the selection.
Select a cell in the row or column, and then press CTRL+ARROW key (RIGHT ARROW or LEFT
ARROW for rows, UP ARROW or DOWN ARROW for columns).
Press CTRL+HOME to select the first cell on the worksheet or in an Excel list.
Press CTRL+END to select the last cell on the worksheet or in an Excel list that contains data or
formatting.
Select the first cell, and then press CTRL+SHIFT+END to extend the selection of cells to the last
used cell on the worksheet (lower-right corner).
Select the first cell, and then press CTRL+SHIFT+HOME to extend the selection of cells to the
beginning of the worksheet.
Hold down SHIFT while you click the last cell that you want to include in the new selection. The
rectangular range between the active cell and the cell that you click becomes the new selection.

To cancel a selection of cells, click any cell on the worksheet.
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➢➢ To Apply a cell style

Mouse
a) Select the cells that you want to format.
b) On the Home ribbon, in the Styles group, click Cell Styles.
c) Click the cell style that you want to apply.
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➢➢ To create custom cell style
Mouse
a) On the Home ribbon, in the Styles group, click Cell Styles.
b) Click New Cell Style.
c) In the Style name box, type an appropriate name for the new cell style.
d) Click Format.
e) On the various tabs in the Format Cells dialog box, select the formatting that you want, and then click
OK.
f) In the Style dialog box, under Style Includes (By Example), clear the check boxes for any
formatting that you don’t want to include in the cell style.
g) To remove a cell style from selected cells without deleting the cell style, select the cells that are formatted
with that cell style.
➢➢ To remove a cell style
Mouse
a) On the Home ribbon, in the Styles group, click Cell Styles.
b) To remove the cell style from the selected cells without deleting the cell style, under Good, Bad, and
Neutral, click Normal.
OR
c) To delete the cell style and remove it from all cells that are formatted with it, right-click the cell style, and
then click Delete.
You cannot delete the Normal cell style.

Conditional Formatting
Whenever you analyze data, you often ask yourself questions, such as:
•

Where are the exceptions in a summary of profits over the past five years?

•

What are the trends in a marketing opinion poll over the past two years?

•

Who has sold more than £50,000 this month?

•

What is the overall age distribution of employees?

•

Which products have greater than 10% revenue increases from year to year?

•

Who are the highest performing and lowest performing students in the new student class?
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Conditional formatting helps to answer these questions by making it easy to highlight interesting cells or ranges of cells,
emphasize unusual values, and visualize data by using data bars, colour scales and icon sets. A conditional format changes
the appearance of a cell range based on a condition (or criteria). If the condition is true, the cell range is formatted based
on that condition; if the conditional is false, the cell range is not formatted based on that condition.
When creating a conditional format, you can reference other cells in a worksheet, such as =FY2006!A5, but you cannot
use external references to another workbook.
➢➢ To Format all cells by using a two-colour scale
Colour scales are visual guides that help you understand data distribution and variation. A two-colour scale helps you
compare a range of cells by using a gradation of two colours. The shade of the colour represents higher or lower values.
For example, in a green and red colour scale, you can specify higher value cells have a greener colour and lower value
cells have a redder colour.
Mouse

a) Select a range of cells, or make sure that the active cell is in a table or PivotTable report.
b) On the Home ribbon, in the Styles group, click the arrow next to Conditional Formatting,
and then click Colour Scales.
c) Select a two-colour scale.
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Hover over the colour scale icons to see which one is a two-colour scale. The top colour represents higher values and the
bottom colour represents lower values.

CHALLENGING PERSPECTIVES

Internship opportunities
EADS unites a leading aircraft manufacturer, the world’s largest
helicopter supplier, a global leader in space programmes and a
worldwide leader in global security solutions and systems to form
Europe’s largest defence and aerospace group. More than
140,000 people work at Airbus, Astrium, Cassidian and Eurocopter,
in 90 locations globally, to deliver some of the industry’s most
exciting projects.
An EADS internship offers the chance to use your theoretical
knowledge and apply it first-hand to real situations and assignments
during your studies. Given a high level of responsibility, plenty of

learning and development opportunities, and all the support you need,
you will tackle interesting challenges on state-of-the-art products.
We welcome more than 5,000 interns every year across
disciplines ranging from engineering, IT, procurement and
finance, to strategy, customer support, marketing and sales.
Positions are available in France, Germany, Spain and the UK.
To find out more and apply, visit www.jobs.eads.com. You can also
find out more on our EADS Careers Facebook page.
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➢➢ To manage rules for advanced formatting.
Mouse
a) Select a range of cells, or make sure that the active cell is in a table or PivotTable report.
b) On the Home ribbon, in the Styles group, click the arrow next to Conditional Formatting,
and then click Manage Rules.
c) The Conditional Formatting Rules Manager dialog box is displayed.
➢➢ To add a conditional format (new rule).
Mouse
a) click New Rule. The New Formatting Rule dialog box is displayed.

b) Select a rule type from top section of dialog.
c) Edit the rule description in bottom section. Rule descriptions will change dependent on the rule type.
d) Select the colours you wish to apply if the conditions you have set are met.
e) Click ok to create the rule the rule will then appear in the rule manager.
f) Click ok to apply the rule and close the rule manager
➢➢ To conditionally format to two colour scale (advanced)
Mouse
a) On the Home ribbon, in the Styles group, click the arrow next to Conditional Formatting,
and then click Manage Rules.
b) The Conditional Formatting Rules Manager dialog box is displayed.
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c) Make sure that the appropriate worksheet or table is selected in the Show formatting rules for
list box. 
d)

Optionally, change the range of cells by clicking
Collapse Dialog in the Applies to box to
temporarily hide the dialog box, selecting the new range of
cells on the worksheet, and then selecting Expand Dialog.

e)

Select the rule, and then click Edit rule. The Edit
Formatting Rule dialog box is displayed.

f) Under Select a Rule Type, click Format all cells based on their values.
g) Under Edit the Rule Description, in the Format Style list box, select 2-Color Scale.
h) Select a Minimum and Maximum Type
•

Format lowest and highest values Select Lowest Value and Highest Value. In this case, you do
not enter a Minimum and Maximum Value.

•

Format a number, date, or time value Select Number, and then enter a Minimum and Maximum
Value.

•

Format a percentage Select Percent, and then enter a Minimum and Maximum Value. Valid values
are from 0 to 100. Do not enter a percent sign. Use a percentage when you want to visualize all values
proportionally because the distribution of values is proportional.

•

Format a percentile Select Percentile and then enter a Minimum and Maximum Value. Valid
percentiles are from 0 to 100. You cannot use a percentile if the range of cells contains more than 8,191 data
points. Use a percentile when you want to visualize a group of high values (such as the top 20thpercentile)
in one colour grade proportion and low values (such as the bottom 20th percentile) in another colour grade
proportion, because they represent extreme values that might skew the visualization of your data.

•

Format a formula result Select Formula, and then enter a Minimum and Maximum Value. The
formula must return a number, date or time value. Start the formula with an equal sign (=). Invalid formulas
result in no formatting applied. It’s a good idea to test the formula in the worksheet to make sure that it
doesn’t return an error value.

Minimum and Maximum values are the minimum and maximum values for the range of cells. Make sure that the
Minimum value is less than the Maximum value.
You can choose a different Minimum and Maximum Type. For example, you can choose a Minimum Number and
Maximum Percent.
i) To choose a Minimum and Maximum colour scale, click Colour for each, and then select a colour. If
you want to choose additional colours or create a custom colour, click More Colours.

Download free eBooks at bookboon.com

65

Excel 2007 Advanced: Part II

Other formatting

j) The colour scale that you select is displayed in the Preview box.
k) Click ok to return to the rule manager
l) Click ok to apply the new rule to selected cells and close rule manager.
➢➢ To Format all cells by using data bars quick formatting
A data bar helps you see the value of a cell relative to other cells. The length of the data bar represents the value in the cell.
A longer bar represents a higher value and a shorter bar represents a lower value. Data bars are useful in spotting higher
and lower numbers especially with large amounts of data, such as top and bottom selling toys in a holiday sales report.
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Mouse

.

a) Select a range of cells, or make sure that the active cell is in a table or PivotTable report.
b) On the Home ribbon, in the Style group, click the arrow next to Conditional Formatting,
click Data BARS and then select a data bar icon.
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➢➢ To Format all cells by using data bars advanced formatting
Mouse
a) Select a range of cells, or make sure that the active cell is in a table or PivotTable report.
b) On the Home ribbon, in the Styles group, click the arrow next to Conditional Formatting, and then click
Manage Rules. The Conditional Formatting Rules Manager dialog box is displayed.
Either
c) To add a conditional format, click New Rule. The New Formatting Rule dialog box is displayed.
OR
d) To change a conditional format, Make sure that the appropriate worksheet or table is selected in the Show
formatting rules for list box.
e)

Optionally, change the range of cells by clicking Collapse Dialog in the Applies to box to
temporarily hide the dialog box, selecting the new range of cells on the worksheet, and then selecting
Expand Dialog .

f)

Select the rule, and then click Edit rule. The Edit Formatting Rule dialog box is displayed.

g) Under Select a Rule Type, click Format all cells based on their values.
h) Under Edit the Rule Description, in the Format Style list box, select Data Bar.
i) Select a Shortest Bar and Longest Bar Type.
•

Format lowest and highest values Select Lowest Value and Highest Value. In this case, you do
not enter a Shortest Bar and Longest Bar Value.

•

Format a number, date, or time value Select Number, and then enter a Shortest Bar and
Longest Bar Value.

•

Format a percentage Select Percent, and then enter a Shortest Bar and Longest Bar Value. Valid
values are from 0 to 100. Do not enter a percent sign. Use a percentage when you want to visualize all
values proportionally because the distribution of values is proportional.

•

Format a percentile Select Percentile and then enter a Shortest Bar and Longest Bar Value. Valid
percentiles are from 0 to 100. You cannot use a percentile if the range of cells contains more than 8,191 data
points. Use a percentile when you want to visualize a group of high values (such as the top 20th percentile)
in one data bar proportion and low values (such as the bottom 20th percentile) in another data bar
proportion, because they represent extreme values that might skew the visualization of your data.
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Format a formula result Select Formula, and then enter a Shortest Bar and Longest Bar Value. The
formula must return a number, date or time value. Start the formula with an equal sign (=). Invalid formulas
result in no formatting applied. It’s a good idea to test the formula in the worksheet to make sure that it
doesn’t return an error value.

Make sure that the Shortest Bar value is less than the Longest Bar value.
You can choose a different Shortest Bar and Longest Bar Type. For example, you can choose a Shortest Bar Number and
Longest Bar Percent. To choose a Shortest Bar and Longest Bar colour scale, click Bar Colour. If you want to choose
additional colours or create a custom colour, click More Colours. The bar colour that you select is displayed in the
Preview box. To show only the data bar and not the value in the cell, select Show Bar Only.
➢➢ To Clear conditional formats (worksheet)
Mouse
a) On the Home ribbon, in the Styles group, click the arrow next to Conditional Formatting,
and then click Clear Rules.
b) Click Entire Sheet.
➢➢ To Clear conditional formats (A range of cells, table, or PivotTable)
Mouse
a) Select the range of cells, table or PivotTable for which you want to clear conditional formats.
b) On the Home ribbon, in the Styles group, click the arrow next to Conditional Formatting,
and then click Clear Rules.
c) Depending on what you have selected, click Selected Cells, This TABLE or This PivotTable.
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Section 8 Other Excel features
8.1

Inserting, Formatting and Deleting Objects

Inserting A Drawing Object
Inserting pictures, text boxes, callouts, scanned images etc onto a worksheet can greatly enhance your overall spreadsheet
appearance. The subject of dealing with these objects will be looked at more thoroughly in PowerPoint as that application
deals primarily with inserted objects and how to deal with them as word works primarily with text and excel with figures,
however here is a brief rundown of some items you may insert and how to deal with them.

We will turn your CV into
an opportunity of a lifetime
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We will appreciate and reward both your enthusiasm and talent.
Send us your CV. You will be surprised where it can take you.

Send us your CV on
www.employerforlife.com
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➢➢ To insert a shape onto worksheet.
Mouse
a) On the insert ribbon in the illustrations group, click on the drop down arrow to the right of
shapes.
b) Make a selection by clicking with the left mouse button on the desired shape. If you cannot immediately find
what you want, scroll down using the scroll bar to the right to locate other shapes.
c) The menu will dissappear but your mouse cursor will appear as a small black cross. Click and drag
diagaonally to place the shape on the worksheet.
➢➢ To move or resize shape
Mouse
a) Select shape by clicking on it selection will be shown by handles appearing around the shape.
b) Moving mouse cursor over shape should give a four pointed arrow clicking and dragging with this cursor
will move the shape to desired position.
OR
a) Use cursor keys for small adjustments in moving shape around worksheet.
b) Moving mouse cursor over a handle will give a black two pointed arrow. Clicking and dragging will resize
the shape to appropriate size.
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➢➢ To delete a shape
Mouse
a) Select shape by clicking on it selection will be shown by handles appearing around the shape.
b) Press delete on the keyboard to remove shape.

SmartArt
A SmartArt graphic is a visual representation of your information and ideas. You can create SmartArt graphics by choosing
from among many different layouts to quickly, easily and effectively communicate your message.

Download free eBooks at bookboon.com

71

Excel 2007 Advanced: Part II

Other Excel features

Most people create content that contains only text, even though illustrations and graphics help audiences understand
and recall information better than text. Creating designer-quality illustrations can be challenging, especially if you are
not a professional designer or you cannot afford to hire a professional designer. If you use earlier versions of Microsoft
Office, you can spend a lot of time making shapes the same size and aligning them properly, getting your text to look
right, and manually formatting the shapes to match the document’s overall style, instead of focusing on your content.
With SmartArt graphics and other new features such as themes, you can create designer-quality illustrations with only a
few clicks of your mouse.
When you create a SmartArt graphic, you are prompted to choose a type such as Process, Hierarchy, Cycle, or
Relationship. A type is similar to a category of SmartArt graphic, and each type contains several different layouts.
When you choose a layout for your SmartArt graphic, ask yourself what you want to convey and whether you want your
information to appear a certain way. Because you can quickly and easily switch layouts, try different layouts (across types)
until you find the one that best illustrates your message. Experiment with different types and layouts by using the table
below as a starting point.
When you switch layouts, most of your text and other content, colours, styles, effects, and text formatting are automatically
carried over to the new layout.

➢➢ To insert a SmartArt graphic
Mouse
a) On the insert ribbon in the illustrations group, click on the drop down arrow to the right of
smartart the smartart dialog above will appear
b) Choose a category from the left thena graphic from the centre to see a preview on the right.
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c) When you have the selection you desire click ok to insert the smartart on your worksheet
d) The smart art will appear on your worksheet as in picture below.
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About the Text pane
The Text pane is the pane that you can use to enter and edit the text that appears in your SmartArt graphic. The Text pane
appears to the left of your SmartArt graphic. As you add and edit your content in the Text pane, your SmartArt graphic
is automatically updated— shapes are added or removed as needed.
When you create a SmartArt graphic, the SmartArt graphic and its Text pane are populated with placeholder text that you
can replace with your information. At the top of the Text pane, you can edit the text that will appear in your SmartArt
graphic. At the bottom of the Text pane, you can view additional information about the SmartArt graphic.
➢➢ To enter text into SmartArt
Mouse
a) Click on placeholder in the text pane.
b) Placeholder text will disappear.
c) Type required text and press enter
d) Focus will create a new placeholder and new shape waiting for text
e) Press tab to move the text lower in the hierarchy in the example above or shift + Tab to move it higher.
➢➢ To remove a SmartArt shape
Mouse
a) Select the text or placeholder text of the shape you wish to remove in the text pane.
b) Press delete key on keyboard
c) Both text and shape will be removed from graphic

WordArt
WordArt is a gallery of text styles that you can add to your 2007 Microsoft Office system documents to create decorative
effects, such as shadowed or mirrored (reflected) text. You can change WordArt text, as you can change any other text
in a shape.
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Mouse
On the Insert ribbon, in the Text group, click WordArt, and then click the WordArt style that you want.
d) Enter your text.#
e) A WordArt graphic can be resized, rotated, deleted and moved like any other shape.

Formatting Shapes
Any shape inserted on the spreadsheet, when selected, causes a new ribbon to appear called the format ribbon seen
below, it offers the options of inserting further shapes. Formatting all aspects of the selected shape and fixing a specific
size. The easiest method of formatting your shape is to use the QuickStyle option in the shape styles group

QuickStyles
Quick Styles are combinations of different formatting options and are displayed in a thumbnail in the various Quick
Style galleries. When you place your pointer over a Quick Style thumbnail, you can see how the Quick Style affects your
SmartArt graphic or shape.
Quick Styles for SmartArt graphics (SmartArt Styles) include edges, shadows, line styles, gradients and three-dimensional
(3-D) perspectives. Try different combinations of SmartArt Styles and colours until you find one that matches the message
that you want to communicate. You can pick a layout, a SmartArt Style, and a colour variation that you like, and then
change the layout again — your SmartArt Style and colours will stay with your SmartArt graphic, so that you do not
need to re-do them.
SmartArt Styles map the theme effects (theme effects: A set of visual attributes that is applied to elements in a file. Theme
effects, theme colours and theme fonts compose a theme.) of the document theme to the shapes within the SmartArt
graphic. For example, shapes might have thick lines or edges, while arrows might have a more subtle style applied to them.
You can also apply colours from the theme colours of the document in different ways, such as changing the colour of the
shape border. If you create multiple SmartArt graphics and want them to look alike, you can apply the same colours and
SmartArt Style to achieve a consistent, professional look.
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You can have shapes that display with edges, depth, and rotate in 3-D space. To make a SmartArt graphic threedimensional, apply a 3-D SmartArt Style or manually apply a 3-D rotation to each shape. If the entire SmartArt graphic
is three-dimensional (called scene coherent 3D), you can continue to edit the text and formatting of each of the individual
shapes, but the shapes cannot be repositioned or resized. You can only reposition or resize shapes in a two-dimensional
scene. To switch between 2-D and 3-D, under SmartArt Tools, on the Format ribbon, in the Shapes group, click Edit
in 2-D. The Edit in 2-D button temporarily unlocks your SmartArt graphic for editing so that you can move and resize
shapes— but the 3-D SmartArt Style is still applied to your SmartArt graphic and reappears when you click Edit in 2-D
again. When your SmartArt graphic is displayed in a 3-D scene, you can rotate it as a whole and position light sources
and the “camera” such that the entire SmartArt graphic appears to pop out of the screen.
SmartArt Styles affect an entire SmartArt graphic, while Quick Styles for Shapes (Shape Styles) affect only the selected
shape. You can manually customize a shape by changing the colour, effects or border, or by replacing it with another
shape. It is recommended that you customize your SmartArt graphic only after you settle on its content and layout, as
some customizations are not transferred because they might not look good in the new layout. For more information about
switching layouts for SmartArt graphics, see Switch the layout or type of a SmartArt graphic.

Download free eBooks at bookboon.com

76

Click on the ad to read more

Excel 2007 Advanced: Part II

Other Excel features

➢➢ To apply a QuickStyle
Mouse
a) Select the shape or shapes you wish to apply a QuickStyle to.
b) As you move your mouse over the various options your shape on the worksheet will temporarily take on that
format as a preview. See below.
c) If you prefer to look at the other them fills option at the bottom you will be given the above options
d) When you locate the style you want click on it to apply it to your shape.

Manual Formatting

Manual formatting can be applied as well. Fill, border, 3D, rotation etc using various tools from the format ribbon. There
are also tools for aligning, layering and sizing your shape as in a desktop publishing programme.

Download free eBooks at bookboon.com

77

Excel 2007 Advanced: Part II

Other Excel features

➢➢ To change fill colour

Mouse
a) Select shape to be formatted select fill colour from the shape styles group.
b) Select a theme colour, standard colour, gradient, texture, picture or more
fill colours.
more fill colours gives a palette with any possible colour you may require. You may match a colour if you know the rgb
or cymk numbers)
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➢➢ To change a border
Mouse
a) Select shape to be formatted select shape outline from the shape styles group.
b) Select a theme colour, standard colour or more outline colours.
c) when you have selected a colour for your shapes outline you may wish to make it thicker or to have a dashed
style. Repeat step one and select weight or dashes and make a selection to apply to your shape.
The arrows option is available if your shape happens to be any kind of line you may choose an arrow style as well as
a weight and line style
➢➢ To apply shape effects
Mouse
a) Select shape to be formatted. Click on shape effects to see menu on right
b) The preset menu shows popular styles made up of the other menu choices. Select a preset to apply.
c) You may alter aspects of the preset by repeating and selecting a different menu choice.
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Using all formatting choices shown gives a very professional finish to any object placed on the worksheet many of these
options are available for charts and pictures.

8.2

Reviewing

Protecting

When sending your work to someone else to check, make corrections or comments it is necessary to track the changes
that others may make to your work to see what changes they have made as they review your work. You may also want to
restrict what they are allowed to do to your work so they do not inadvertently damage formulae and functions that make
the workbook produce valid figures. For these reasons we may have to protect the workbook in various ways.
➢➢ To protect a workbook
Protecting a workbook ensures individuals cannot, insert, delete, move or otherwise tamper with the sheets in your work
book. Hidden sheets will not be able to be unhidden if valuable tables or data is stored on them.
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Mouse
a) Click on protect workbook in the changes group on the review ribbon
b) Select protect structure and windows the following dialog will appear.

c) For security (not essential) enter a password and click on ok. Workbook structure is now protected.
➢➢ To unprotect a workbook
Mouse
a) Click on protect workbook in the changes group on the review ribbon
b) Select unprotect structure and windows a dialog will appear asking for password
c) Enter password, click on ok, workbook is now unprotected
➢➢ Protect worksheet data
Mouse
a) Select all cells you would like individuals to be allowed to change.
b) On the Home ribbon, in the Cells group, click Format, and then click Format Cells.
c) Click on the protection tab
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d) Untick lock cells.

e) Click on protect worksheet in the changes group on the review ribbon.
f) Tick what you wish users to be allowed to do in the locked cells.
g) Enter a password if you wish
h) Click on OK.
i) Sheet is now protected any cell that was locked is now uneditable by anyone.
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➢➢ To unprotect worksheet data
Mouse
a) Click on protect worksheet in the changes group on the review ribbon
b) Enter password to unprotect sheet
c) Click OK
➢➢ To protect for tracked changes
Mouse
a) Click on Track changes and then highlight changes in the changes group on the
review ribbon
b) The highlight changes dialog will appear.
c) Tick the track changes while editing option
d) Click on OK.
e) Any changes made to the workbook by anyone now will leave a mark in the cell to show it has been changed
by who, when and what the change is.

➢➢ To Accept/reject changes
When changes have been made to your workbook you may wish to check those changes and see what has been altered.
You may not be happy with some of the changes and wish to reject them for what was previously within a cell.
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Mouse
a) Click on Track changes and then accept/reject changes in the changes group on the
review ribbon.
b) The select changes to accept or reject dialog will appear.

c) Click ok. The accept or reject changes dialog will appear

d) As you accept or reject each change the dialog will automatically move on to the next change. When you
have finished click close to close the dialog and finish reviewing.

Use A Shared Workbook To Collaborate
You can create a shared workbook and place it on a network location where several people can edit the contents
simultaneously. For example, if the people in your work group each handle several projects and need to know the status
of each other’s projects, the group can use a shared workbook to track the status of the projects. All persons involved can
then enter the information for their projects in the same workbook.
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As the owner of the shared workbook, you can manage it by removing users from the shared workbook and resolving
conflicting changes. When all changes have been incorporated, you can stop sharing the workbook.

Share A Workbook
Create a new workbook and enter any data that you want to provide, or open an existing workbook that you want to
make available for multi-user editing.
Not all features are supported in a shared workbook. If you want to include any of the following features, you should add
them before you save the workbook as a shared workbook: merged conditional formats data validation, charts, pictures,
objects including drawing objects, hyperlinks scenarios, outlines subtotals, data tables PivotTable reports workbook and
worksheet protection, and macros. You cannot make changes to these features after you share the workbook.

.
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Features that are not supported in a shared workbook
In a shared workbook, you cannot
Create an Excel table
Insert or delete blocks of cells
Delete worksheets
Merge cells or split merged cells
Add or change conditional formats

Add or change data validation
Create or change charts or PivotChart
reports
Insert or change pictures or other objects
Insert or change hyperlinks
Use drawing tools
Assign, change, or remove passwords
Protect or unprotect worksheets or the
workbook
Create, change, or view scenarios
Group or outline data
Insert automatic subtotals
Create data tables
Create or change PivotTable reports
Write, record, change, view, or assign macros

Add or change Microsoft Excel 4 dialog
sheets
Change or delete array formulas
Use a data form to add new data
Work with XML data, including:

•

Import, refresh, and export XML data

•

Add, rename, or delete XML maps

•

Map cells to XML elements

•

Use the XML Source task pane, XML

But you may be able to do the following
None
You can insert entire rows and columns.
None
None
Existing conditional formats continue to appear as cell values
change, but you can’t change these formats or redefine the
conditions.
Cells continue to be validated when you type new values, but
you can’t change existing data validation settings.
You can view existing charts and reports.
You can view existing pictures and objects.
Existing hyperlinks continue to work.
You can view existing drawings and graphics.
Existing passwords remain in effect.
Existing protection remains in effect.
None
You can continue to use existing outlines.
You can view existing subtotals.
You can view existing data tables.
You can view existing reports.
You can run existing macros that don’t access unavailable
features. You can record shared workbook operations into a
macro stored in another nonshared workbook.
None
Existing array formulas continue to calculate correctly.
You can use a data form to find a record.
None

toolbar, or XML commands on the
Data menu
➢➢ To share a workbook
Mouse
a) On the Review tab, in the Changes group, click Share Workbook.
b) On the Editing tab, select the Allow changes by more than one user at the same
time. This also allows workbook merging check box.
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c) On the Advanced tab, select the options that you want to use for tracking and updating changes, and
then click OK.
d) If this is a new workbook, type a name in the File name box.
OR
a)

If this is an existing workbook, click OK to save the workbook, click Microsoft Office BUTTON
and then click Save As.

b) In the Save in box, select a network location that is accessible to the intended users, and then click Save.
You should use a shared network folder, not a Web server.
i.

If the workbook contains links to other workbooks or documents, verify the links and update any links
that are broken, and then click Save on the Quick Access Toolbar, or press CTRL+S.

➢➢ To verify and update links to other workbooks or documents
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a) On the Data tab, in the Connections group, click Edit Links.
The Edit Links to Files command is unavailable if your file does not contain linked information.
b) Click Check Status to verify the status for all links in the list.
This may take a while if there are many links, or if the source workbook for the links is on a network location, and the
network is slow.
c) Check the status in the Status column, click the link and then take the action that is needed.
If the status is
OK
Unknown
N/A
Error: Source not found
Error: Worksheet not
found
Warning: Values not
updated
Warning: Click Open
Source, and calculate the
workbook by pressing F9
Warning: Some names
cannot be resolved until
the source workbook is
opened
Warning: Click Open
Source
Source is open
Values updated from file
name
Warning: Excel cannot
determine the status of
the link

Take this action
No action is required. The link is working and up to date.
Click Check Status to update the status for all links in the list.
The link uses Object Linking and Embedding (OLE) or Dynamic Data Exchange
(DDE)Microsoft Office Excel cannot check the status of these types of links.
Click Change Source, and then select another workbook.
Click Change Source, and then select another worksheet. The source may have
been moved or renamed.
Click Update Values. The link was not updated when the workbook was
opened.
The workbook may be set to manual calculation. To set the workbook to
automatic calculation, click Microsoft Office Button , and then click Excel
Options. In the Formulas category, under Calculation options, click
Automatically.
Click Open Source, switch back to the destination workbook and then click
Check Status. If this does not resolve the problem, make sure that the name
is not misspelled or missing. Switch to the source workbook, and then on the
Formulas tab, in the Named Cells group, click Name Manager, and look
for the name.
The link cannot be updated until the source is open.
The status of a link cannot be checked.
No action is required. The values have been updated.
The source may contain no worksheets or may be saved in an unsupported file
format. Click Update Values.

All users with access to the network share have full access to the shared workbook unless you lock cells and protect
the worksheet to restrict access. To protect a shared workbook, click Protect and Share Workbook in the
Changes group on the Review tab. When you protect a shared workbook, you can set a password that all users must
enter to open the workbook.
To edit the shared workbook, all users must have one of the following installed on their computers: Microsoft Office Excel,
Microsoft Excel 97 or later or Microsoft Excel 98 or later for Macintosh.
Not all Excel features are supported in a shared workbook. For more information, see the table “Features that are not
supported in a shared workbook” above.
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➢➢ To Edit a shared workbook
After you open a shared workbook, you can enter and change data as you do in a regular workbook.
a)

Open the shared workbook.

b) Click the Microsoft Office Button , and then click Excel Options.
c) In the Popular category, under Personalize your copy of Office, in the User Name box,
enter the user name that you want to use to identify your work in the shared workbook, and then click OK.
d) Enter and edit data on the worksheets as usual.
You won’t be able to add or change the following: merged cells, conditional formats, data validation, charts, pictures,
objects including drawing objects, hyperlinks, scenarios, outlines, subtotals, data tables, PivotTable reports, workbook
and worksheet protection, and macros.
Make any filter and print settings that you want for your personal use. Each user’s settings are saved individually by
default.
You can also use the filter or print settings that were made by the owner of the workbook whenever you open the workbook.
e)

To save your changes to the workbook and see the changes that other users have saved since your last
save, click Save on the Quick Access Toolbar, or press CTRL+S. If the Resolve Conflicts
dialog box appears, resolve the conflicts.

To resolve conflicts, see Resolve conflicting changes in a shared workbook in this topic.
You can see who else has the workbook open on the Editing tab of the Share Workbook dialog box (Review tab, Changes
group, Share Workbook button).
You can choose to get automatic updates of the other users’ changes periodically, with or without saving, under Update
changes on the Advanced tab of the Shared Workbook dialog box.
➢➢ To Remove a user from a shared workbook
If needed, you can disconnect users from a shared workbook.
Before disconnecting users, make sure that they have completed their work on the workbook. If you remove an active
user, any unsaved work will be lost.
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Mouse
a) On the Review tab, in the Changes group, click Share Workbook.
b) On the Editing tab, in the Who has this workbook open now list, review the names of users.
c) Select the name of the user who you want to disconnect, and then click Remove User.
Although this action disconnects the user from the shared workbook, it does not prevent that user from editing the
shared workbook again.
➢➢ To delete any personal view settings of the removed user, do the following:

Mouse
a) On the View tab, in the Workbook Views group, click Custom Views.
b) n the Views list, select the view of another user, and then click Delete.
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➢➢ Resolve conflicting changes in a shared workbook
A conflict happens when two users are both editing the same shared workbook and try to save changes that affect the
same cell. Excel can keep only one of the changes in that cell. When the second user saves the workbook, Excel displays
the Resolve Conflicts dialog box.
Mouse
a) In the Resolve Conflicts dialog box, read the information about each change and the conflicting
changes made by the other user.
b) To keep your change or the other person’s change and to advance to the next conflicting change, click
Accept Mine or Accept Other. To keep all of your remaining changes or all of the other user’s
changes, click Accept All Mine or Accept All Others.
➢➢ To override resolve conflicts dialog
To have your changes override all other changes without displaying the Resolve Conflicts dialog box again,:
Mouse
a) On the Review tab, in the Changes group, click Share Workbook.
b) On the Advanced tab, under Conflicting changes between users, click The changes
being saved win, and then click OK.
➢➢ To view how you or others resolved past conflicts
a) On the Review tab, in the Changes group, click Track Changes, and then click Highlight
Changes.
b) In the When list, select All.
c) Clear the Who and Where check boxes.
d) Select the List changes on a new sheet check box, and then click OK.
e) On the History worksheet, scroll to the right to view the Action Type and Losing Action columns.
Conflicting changes that were kept have Won for Action Type. The row numbers in the Losing Action column identify the
rows with information about the conflicting changes that were not kept, including any deleted data. History worksheet
is A separate worksheet that lists changes being tracked in a shared workbook, including the name of the person who
made the change, when and where it was made, what data was deleted or replaced, and how conflicts were resolved.)
To save a copy of the workbook with all your changes, click Cancel in the Resolve Conflicts dialog box, click Microsoft
Office Button, click Save As, and then type a new name for the file.
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➢➢ To Stop sharing a workbook
Before you stop sharing the workbook, make sure that all other users have completed their work. Any unsaved changes
will be lost. Because the change history will also be deleted, you may want to start by printing the History worksheet or
by copying it to another workbook.
➢➢ To keep a copy of the change history information.
a) On the Review tab, in the Changes group, click Track Changes, and then click Highlight
Changes.
b) In the When list, select All.
c) Clear the Who and Where check boxes.
Select the List changes on a new sheet check box, and then click OK.

d)
•

To print the History worksheet, click Microsoft Office Button , and then click Print.

•

To copy the history to another workbook, select the cells that you want to copy, click Copy on the Home
ribbon in the Clipboard group, switch to another workbook, click where you want to place the copied
data, and then click Paste on the Home tab in the Clipboard group.

You may also want to save or print the current version of the workbook, because this history data might not apply to
later versions of the workbook. For example, cell locations, including row numbers, in the copied history may no longer
be current.
a) In the shared workbook, on the Review tab, in the Changes group, click Share Workbook.
b) On the Editing tab, make sure that you are the only person listed in the Who has this
workbook open now list.
c) Clear the Allow changes by more than one user at the same time. This also
allows workbook merging check box.
d) When you are prompted about the effects on other users, click Yes
If this check box is not available, you must first unprotect the workbook. To remove shared workbook protection,
➢➢ To unprotect shared workbook
Mouse
a) Click OK to close the Share Workbook dialog box.
b) On the Review tab, in the Changes group, click Unprotect Shared Workbook.
c) If you are prompted, enter the password (A way to restrict access to a workbook, worksheet or part of a
worksheet. Excel passwords can be up to 255 letters, numbers, spaces and symbols. You must type uppercase
and lowercase letters correctly when you set and enter passwords.), and then click OK.
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d) On the Review tab, in the Changes group, click Share Workbook.
e) On the Editing tab, clear the Allow changes by more than one user at the same
time. This also allows workbook merging check box.
f) When you are prompted about the effects on other users, click Yes.

8.3

Proofing Tools

Spelling And Grammar 
As a deadline approaches, often there is not enough time to check a document for spelling and grammar
mistakes. Your Microsoft Office program provides tools that can help you correct these mistakes faster. You decide if you
want to set up the Microsoft Office program so that you can easily see potential mistakes while you work. Or, if you find
the wavy red and green lines distracting, you can just check your document when you are ready to finish it.
Maybe you are looking for a way to find and fix spelling mistakes in your document more quickly and easily? Or maybe
you don’t want to see the wavy red lines that your Microsoft Office program displays in your document? This section
explains how automatic spelling and grammar checking works and how to turn it on or off.
There is no option to check spelling while you type in Microsoft Office Access, Microsoft Office Excel or Microsoft Office
Project.
Grammar checking is available only in Microsoft Office Outlook and Microsoft Office Word.
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➢➢ To check spelling
Mouse
a) Click inside a worksheet that you are editing to check the entire active worksheet, including cell values,
cell comments, embedded charts, text boxes, buttons, headers, and footers. Excel does not check protected
worksheets, formulas or text that results from a formula. Also, if the formula bar is active when you check
spelling, Excel checks only the contents of the formula bar.
b) Optionally, to check only a specific piece of text, select the text you want to check.
c) Click on spellchecker in the proofing group on the review ribbon.
d) If the program finds spelling mistakes, a dialog box or task pane is displayed, and the first misspelled word
found by the spelling checker is selected. You decide how you want to resolve each error that the program
finds.
e) After you resolve each misspelled word, the program flags the next misspelled word, so that you can decide
what you want to do.

f) When all spelling has been corrected a dialog appears telling you that the spell check is complete
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Thesaurus
➢➢ To use thesaurus
Mouse

a) On the Review tab, click Thesaurus.
b) Press ALT and click the word that you want to look up. Results appear in the Research task pane.
You can type a word or phrase in the Search for box, and then click Start Searching .
c) To use one of the words in the list of results or to search for more words, do one of the following:
d) To use one of the words, point to it, click the down arrow and then click Insert or Copy.
e) To look up additional related words, click a word in the list of results.
You can also look up words in the thesaurus of another language. If, for example, your document is in French and you
want synonyms, click Research options in the Research task pane, and then under Reference Books, select
the thesaurus options that you want.

Translation
Using the Research feature, you can translate single words or short phrases by using bilingual dictionaries or translate
your entire document by using Web-based machine translation services. To translate text, you may also need to satisfy
the operating system requirements for specific languages.

Download free eBooks at bookboon.com

95

Excel 2007 Advanced: Part II

Other Excel features

a) On the Review tab, click Translate.
b) The translation service appears in the Research task pane.
c) To change the languages that are used for translation, in the Research task pane, under
Translation, select the languages that you want to translate from and to. For example, to translate
English to French, click English (U.S.) in the From list and French (France) in the To list.
d) To translate a specific word, press ALT and click a word. The results appear in the Research task pane
under Translation.
e) To translate a short phrase, select the words, press ALT and click the selection. The results appear in the
Research task pane under Translation.
You can type a word or phrase in the Search for box, and then click Start Searching .

Show Or Hide ScreenTips
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ScreenTips are small windows that display descriptive text when you rest the pointer on a command or control.
Enhanced ScreenTips are larger windows that display more descriptive text than a ScreenTip and can have a link to a
Help topic. Enhanced ScreenTips are available in the following 2007 Microsoft Office system programs: Access, Excel,
PowerPoint and Word.
Click the Microsoft Office Button , and then click Program Name Options, where

a)

Program Name is the name of the program you are in, for example, Word Options.
b) Click Popular.
c) Under Top options for working with Program Name, in the ScreenTip style list,
click the option that you want:
Show feature descriptions in ScreenTips This option turns on ScreenTips and Enhanced ScreenTips. This
is the default setting.
Don’t show feature descriptions in ScreenTips This option turns off Enhanced ScreenTips. You still
see ScreenTips.
Don’t show ScreenTips This option turns off ScreenTips and Enhanced ScreenTips.
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Excel 2007 specifications and limits
➢➢ Worksheet and workbook specifications and limits
Feature
Open workbooks
Worksheet size
Column width
Row height
Page breaks
Total number of characters that a cell can contain
Characters in a header or footer
Sheets in a workbook
Colours in a workbook
Named views (view: A set of display and print settings that you can name
and apply to a workbook. You can create more than one view of the same
workbook without saving separate copies of the workbook.) in a workbook
Unique cell formats/cell styles
Fill styles
Line weight and styles
Unique font types
Number formats in a workbook

Names in a workbook
Windows in a workbook
Panes in a window
Linked sheets
Scenarios (scenario: A named set of input values that you can substitute in a
worksheet model.)
Changing cells in a scenario
Adjustable cells in Solver
Custom functions
Zoom range
Reports
Sort references
Undo levels
Fields in a data form
Workbook parameters
Filter drop-down lists
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Maximum limit
Limited by available memory and system
resources
1,048,576 rows by 16,384 columns
255 characters
409 points
1,026 horizontal and vertical
32,767 characters
255
Limited by available memory (default is
3 sheets)
16 million colours (32 bit with full access
to 24 bit colour spectrum)
Limited by available memory

64,000
32
16
1,024 global fonts available for use; 512
per workbook
Between 200 and 250, depending on the
language version of Excel that you have
installed
Limited by available memory
Limited by available memory
4
Limited by available memory
Limited by available memory; a summary
report shows only the first 251 scenarios
32
200
Limited by available memory
10 percent to 400 percent
Limited by available memory
64 in a single sort; unlimited when using
sequential sorts
100
32
255 parameters per workbook
10,000
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➢➢ Calculation specifications and limits
Feature
Number precision
Largest number allowed to be typed into a cell
Largest allowed positive number
Smallest allowed negative number
Smallest allowed positive number
Largest allowed negative number
Length of formula contents
Internal length of formula
Iterations
Worksheet arrays
Selected ranges
Arguments in a function
Nested levels of functions
User defined function categories
Number of available worksheet functions
Size of the operand stack
Cross-worksheet dependency

Maximum limit
15 digits
9.99999999999999E+307
1.79769313486231E+308
-2.2251E-308
2.229E-308
-1E-307
8,192 characters
16,384 bytes
32,767
Limited by available memory
2,048
255
64
255
341
1,024
64,000 worksheets that can refer to other
sheets
Limited by available memory
Limited by available memory
Limited by available memory
4 billion formulas that can depend on a
single cell
32,767
January 1, 1900 (January 1, 1904, if 1904
date system is used)
December 31, 9999
9999:59:59

Cross-worksheet array formula dependency
Area dependency
Area dependency per worksheet
Dependency on a single cell
Linked cell content length from closed workbooks
Earliest date allowed for calculation
Latest date allowed for calculation
Largest amount of time that can be entered

➢➢ Charting specifications and limits
Feature
Charts linked to a worksheet
Worksheets referred to by a chart
Data series(Related data points that are plotted in a chart. Each data series in
a chart has a unique colour or pattern and is represented in the chart legend.
You can plot one or more data series in a chart. Pie charts have only one data
series.) in one chart
Data points (Individual values that are plotted in a chart. Related data points
make up a data series. Data points are represented by bars, columns, lines,
slices, dots, and other shapes. These shapes are called data markers.) in a data
series for 2-D charts
Data points in a data series for 3-D charts
Data points for all data series in one chart
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Maximum limit
Limited by available memory
255
255

32,000

4,000
256,000
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➢➢ PivotTable and PivotChart report specifications and limits
Feature
PivotTable reports (An interactive, cross tabulated Excel report that summarizes
and analyzes data, such as database records, from various sources, including
ones that are external to Excel.) on a sheet
Unique items per field
Row (A field that’s assigned a row orientation in a PivotTable report. Items
associated with a row field are displayed as row labels.) or column fields(A field
that’s assigned a column orientation in a PivotTable report. Items associated
with a column field are displayed as column labels.) in a PivotTable report
Report filters in a PivotTable report
Value fields in a PivotTable report
Calculated item (An item within a PivotTable field or PivotChart field that uses
a formula you create. Calculated items can perform calculations by using
the contents of other items within the same field of the PivotTable report or
PivotChart report.) formulas in a PivotTable report
Report filters in a PivotChart report(A chart that provides interactive analysis of
data, like a PivotTable report. You can change views of data, see different levels
of detail or reorganize the chart layout by dragging fields and by showing or
hiding items in fields.)
Value fields in a PivotChart report
Calculated item formulas in a PivotChart report
Length of the MDX name for a PivotTable item
Length for a relational PivotTable string

Maximum limit
Limited by available memory

1,048,576
Limited by available memory

256 (may be limited by available memory)
256
Limited by available memory

256 (may be limited by available memory)

256
Limited by available memory
32,767
32,767

➢➢ Shared workbook specifications and limits
Feature
Users who can open and share a shared workbook (shared workbook: A
workbook set up to allow multiple users on a network to view and make
changes at the same time. Each user who saves the workbook sees the
changes made by other users.) at the same time
Personal views (view: A set of display and print settings that you can name
and apply to a workbook. You can create more than one view of the same
workbook without saving separate copies of the workbook.) in a shared
workbook
Days that change history (In a shared workbook, information that is maintained
about changes made in past editing sessions. The information includes the
name of the person who made each change, when the change was made, and
what data was changed.) is maintained
Workbooks that can be merged at one time
Cells that can be highlighted in a shared workbook
Colours used to identify changes made by different users when change
highlighting is turned on
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Maximum limit
256

Limited by available memory

32,767 (default is 30 days)

Limited by available memory
32,767
32 (each user is identified by a separate
colour; changes made by the current user
are highlighted with navy blue)

